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1 Foreword

1.1 Notes on the documentation
This description is only intended for the use of trained specialists in control and automation engineering who
are familiar with applicable national standards.
It is essential that the documentation and the following notes and explanations are followed when installing
and commissioning the components. 
It is the duty of the technical personnel to use the documentation published at the respective time of each
installation and commissioning.

The responsible staff must ensure that the application or use of the products described satisfy all the
requirements for safety, including all the relevant laws, regulations, guidelines and standards.

Disclaimer

The documentation has been prepared with care. The products described are, however, constantly under
development.
We reserve the right to revise and change the documentation at any time and without prior announcement.
No claims for the modification of products that have already been supplied may be made on the basis of the
data, diagrams and descriptions in this documentation.

Trademarks

Beckhoff®, TwinCAT®, TwinCAT/BSD®, TC/BSD®, EtherCAT®, EtherCAT G®, EtherCAT G10®, EtherCAT P®,
Safety over EtherCAT®, TwinSAFE®, XFC®, XTS® and XPlanar® are registered trademarks of and licensed by
Beckhoff Automation GmbH.
Other designations used in this publication may be trademarks whose use by third parties for their own
purposes could violate the rights of the owners.

Patent Pending

The EtherCAT Technology is covered, including but not limited to the following patent applications and
patents:
EP1590927, EP1789857, EP1456722, EP2137893, DE102015105702
with corresponding applications or registrations in various other countries.

EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany

Copyright

© Beckhoff Automation GmbH & Co. KG, Germany.
The reproduction, distribution and utilization of this document as well as the communication of its contents to
others without express authorization are prohibited.
Offenders will be held liable for the payment of damages. All rights reserved in the event of the grant of a
patent, utility model or design.
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1.2 Safety instructions

Safety regulations

Please note the following safety instructions and explanations!
Product-specific safety instructions can be found on following pages or in the areas mounting, wiring,
commissioning etc.

Exclusion of liability

All the components are supplied in particular hardware and software configurations appropriate for the
application. Modifications to hardware or software configurations other than those described in the
documentation are not permitted, and nullify the liability of Beckhoff Automation GmbH & Co. KG.

Personnel qualification

This description is only intended for trained specialists in control, automation and drive engineering who are
familiar with the applicable national standards.

Description of symbols

In this documentation the following symbols are used with an accompanying safety instruction or note. The
safety instructions must be read carefully and followed without fail!

 DANGER
Serious risk of injury!
Failure to follow the safety instructions associated with this symbol directly endangers the life and health of
persons.

 WARNING
Risk of injury!
Failure to follow the safety instructions associated with this symbol endangers the life and health of per-
sons.

 CAUTION
Personal injuries!
Failure to follow the safety instructions associated with this symbol can lead to injuries to persons.

NOTE
Damage to the environment or devices
Failure to follow the instructions associated with this symbol can lead to damage to the environment or
equipment.

Tip or pointer
This symbol indicates information that contributes to better understanding.
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1.3 Notes on information security
The products of Beckhoff Automation GmbH & Co. KG (Beckhoff), insofar as they can be accessed online,
are equipped with security functions that support the secure operation of plants, systems, machines and
networks. Despite the security functions, the creation, implementation and constant updating of a holistic
security concept for the operation are necessary to protect the respective plant, system, machine and
networks against cyber threats. The products sold by Beckhoff are only part of the overall security concept.
The customer is responsible for preventing unauthorized access by third parties to its equipment, systems,
machines and networks. The latter should be connected to the corporate network or the Internet only if
appropriate protective measures have been set up.

In addition, the recommendations from Beckhoff regarding appropriate protective measures should be
observed. Further information regarding information security and industrial security can be found in our
https://www.beckhoff.com/secguide.

Beckhoff products and solutions undergo continuous further development. This also applies to security
functions. In light of this continuous further development, Beckhoff expressly recommends that the products
are kept up to date at all times and that updates are installed for the products once they have been made
available. Using outdated or unsupported product versions can increase the risk of cyber threats.

To stay informed about information security for Beckhoff products, subscribe to the RSS feed at https://
www.beckhoff.com/secinfo.

https://www.beckhoff.com/secguide
https://www.beckhoff.com/secinfo
https://www.beckhoff.com/secinfo
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2 Overview
The TwinCAT 3 Bode Plot is the ideal tool for the analysis and optimization of mechanical resonances within
a mechatronic system. The TwinCAT Bode Plot can be used in connection with the AX5xxx drives from
Beckhoff. It shows the gain and the phase of a system for every frequency within a frequency range. A
graphic display of the stationary reaction, at an output to a harmonic excitation (“sinus oscillation”) at an input
of a system, is thus possible with this tool within the scope of TwinCAT measurement in Visual Studio.
Problematic frequency ranges are easy to recognize in the Bode diagram. With the help of filter sets,
possible filter settings and their effects on the drive can be simulated in the TwinCAT Bode Plot before the
settings for optimizing the drive axis are physically loaded.

Key-Features:
• Illustration of mechanical resonances
• Determination of the bandwidth, as well as phase and amplitude reserves
• Direct simulation of the filter and its effect on the system
• Adaptation of filters to optimize resonance points

Principle of operation:

For the harmonic excitation of a drive axis, the frequencies can be specified in the TwinCAT Bode Plot,
integrated in Visual Studio as an independent Measurement project. The input data are transmitted in the
real-time context and then driven automatically for the selected axis. The current output values for amplitude
gain and phase shift are continuously transmitted during the execution to the charting of the Bode Plot in
order to graphically display the results.

 WARNING
Risk of injury due to the drive axis starting up automatically
In order to make the Bode Plot recording, the drive axis executes a motion sequence that is dependent
upon the settings. At the start of the Bode Plot recording the drive axis starts up automatically in accor-
dance with the set motion profile and can endanger people and material. During the Bode recording the
drive axis remains integrated in the application context (e.g. releases, monitoring, etc.).
• Ensure safety during the Bode Plot recording.

Product level / feature list:

This table shows which functions are available at which product level with the corresponding licensing:

Feature TwinCAT Bode Plot Base
Support AX5xxx From firmware version 2.10
Open Loop

Close Loop

Velocity Mode

Current Mode

Filter simulation

Graph Overlapping

Individual oversampling factor
 (Expert Mode)
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3 Installation

3.1 System requirements
The following system requirements must be fulfilled for proper functioning of the TwinCAT 3 Bode Plot.

Supported operating systems

Windows XP, Windows XP Embedded, Windows Embedded Standard 2009, Windows 7

TwinCAT

Minimum is TwinCAT 3 ADS.

.NET Framework

The .NET Framework 4.0 is required.

The TwinCAT 3 Bode Plot is installed together with TwinCAT 3 XAE. An update of the TwinCAT Bode Plot
independent of TwinCAT XAE can be implemented via the TwinCAT Measurement Setup. The Bode Plot is
free from licensing costs in the base version. Please refer to the product overview page for the functional
scope of the base version.

3.2 Downloading the setup file
Like many other TwinCAT 3 engineering tools, the TwinCAT Bode Plot is available for download on the
Beckhoff website. It is always the most current version of the product, which can be licensed for each
product level. Perform the following steps to download the setup file:

1. Start a web browser of your choice and go to the Beckhoff website at www.beckhoff.com
2. Navigate in the tree to the nodes Automation/TwinCAT3/TE1xxx | TC3 Engineering/TE132x | TC3

Bode Plot
3. Here you can download the TwinCAT Measurement Setup file via the download button. If you select

"Full", the setup also brings along the Microsoft Visual Studio Shell, in which the TwinCAT Bode Plot
integrates itself. If the shell or another full version of Microsoft Visual Studio is already installed on the
target system, the Update setup is sufficient.

4. Click on the Download link in order to place the software in the shopping cart. Then click on "Start
download".

(Optional) Transfer the downloaded file to the TwinCAT runtime system you wish to install the product on.

3.3 Installation
The following section describes how to install the TwinCAT 3 Function for Windows-based operating
systems.

ü The TwinCAT 3 Function setup file was downloaded from the Beckhoff website.
1. Run the setup file as administrator. To do this, select the command Run as administrator in the context

menu of the file.
ð The installation dialog opens.
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2. Accept the end user licensing agreement and click Next.

3. Enter your user data.
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4. If you want to install the full version of the TwinCAT 3 Function, select Complete as installation type. If
you want to install the TwinCAT 3 Function components separately, select Custom.

5. Select Next, then Install to start the installation.

ð A dialog box informs you that the TwinCAT system must be stopped to proceed with the installation.
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6. Confirm the dialog with Yes.

7. Select Finish to exit the setup.

ð The TwinCAT 3 Function has been successfully installed and can be licensed (see Licensing).

3.4 After the Installation
It is not necessary to license the base version. By default the Base product level is active and is available
without a license.

Further steps:

• TwinCAT 3 Bode Plot - first steps [} 33]

• Bode Plot - Architecture [} 16]
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4 Technical introduction

4.1 Bode Plot principles
The Bode diagram is a special representation of a complex transfer function or of a system in the frequency
range. The Bode diagram consists of a graph for the value (amplitude response) and a graph for the phase
shift (phase response). It describes the stationary reaction of the system to a harmonic excitation (sinus
oscillation). The frequency is displayed logarithmically on the X-axes. As a result, the behavior over a wide
frequency range is visible at a glance.

In a servo system, it is possible with the help of the Bode diagram analysis to analyze the behavior of the
closed and open control loops, as well as the transmission link (e.g. the connected mechanism) and to make
or optimize controller and filter settings. In general, this can take place in the typical operating modes -
current, speed and position control - and can also serve as the basis for automatic tuning algorithms. There
are currently two variants in TwinCAT - current and speed control.

Conventional methods, such as optimization to a step response, are usable only to a limited extent. The
Bode diagram contains much more information than the step response and is thus the ideal tool for the
analysis and optimization of control loops.

• The system performance and stability over the entire frequency range are directly visible (accuracy in
the rest position - in the lower frequency range; the dynamic reaction - in the mid frequency range;
noise suppression - in the upper frequency range)

• A bandwidth can be specified more simply and more precisely without disruptions due to noise effects
• Problem frequencies (mechanical resonance points) are simpler to analyze
• Filters can be determined and adapted accordingly

What generates resonances in a drive train?

Each coupling between load and motor has a finite rigidity. This leads to different inertia ratios and different
resonant frequencies of the complete system. These different frequencies are difficult to determine without a
suitable tool. The frequency analysis can be performed with an almost infinitely fine graduation in order to
reliably detect all resonance points.

Mechanical friction must be eliminated during the measurement procedure, otherwise the measurement will
be useless. Therefore, to overcome the static friction, a sine oscillation with a constant low frequency is
additionally applied to the motor shaft. Sine frequencies, increased step by step, are modulated in this
manner. To ensure that the motor current remains more or less constant in speed (and position) control, the
amplitude of the sine oscillations decreases as the frequency increases. The actuating amplitudes are thus
very small at high frequencies. The current in the Bode Plot is constant.

Bode diagram
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Resonance points are represented in a Bode diagram. In the representation, a resonance point consists of
an anti-resonance (frequency response exhibits a pronounced minimum) and a resonance (frequency
response exhibits a pronounced maximum).

The following illustration shows an example of the frequency response of a motor with no load, no resonance
points and quite a wide bandwidth. The closed control loop is uses for the determination of the bandwidth,
while the open control loop is regarded for calculating the amplitude response. The bandwidth is read where
the amplitude response first crosses the -3 dB or the -90° line. The higher the bandwidth of a system, the
more stable it is and the higher the control loop gain can be set. This result in high dynamics.
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A typical curve with resonance points is shown in the next diagram: a curve with two resonance points and
narrow bandwidth.

The second important limit is the +3 dB line. If the amplitude response of the closed control loop exceeds this
limit, this is referred to as positive feedback, analogous to audio (speaker with microphone close to the
loudspeaker).

This positive feedback generates an undesired mechanical oscillation, which can lead to uncontrolled
behavior.

By increasing the P portion (proportional gain), the curve is shifted upwards in parallel to the abscissa; a
reduction has the opposite effect.
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5 Configuration

5.1 Bode Plot

5.1.1 Bode Plot - Architecture
Not only are signal curves represented in the TwinCAT Bode Plot, recording configurations are also created.
For the creation of these configurations, it is important to be familiar with the architecture of the Bode Plot.
The architecture is reflected in the tree structure within the Measurement Project in the Solution Explorer.

The architecture of a Bode project
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Measurement Bode Project:  
The main level, in which several Bode (or Scope) projects can be inserted. The Bode projects within a
Measurement project can be controlled independently of one another.

Bode Project:  
All Bode Plots under a project are executed in parallel when a recording is started. If you click on a Bode
project, the setting options are displayed in the Visual Studio Properties window.
See also: Bode Plot properties [} 23]

Plot:  
Every Bode Plot represents the connection with a drive axis. Several plots can exist in one Bode project.
The display area for a plot contains one chart each for the amplitude and phase responses, in which the
already recorded or generated sets (characteristic curves) for the associated axis are displayed. While one
recording is running, a third chart can also optionally be shown with the current actual and setpoint values.
Apart from the connection data for the drive axis, the parameters for the next recording are also set via the
Bode Plot.
If you click on a Bode project, the setting options are displayed in the Visual Studio Properties window.
See also: Bode Plot properties [} 23]

Set: 
Each set corresponds to a recorded or generated frequency response and represents the resulting
characteristic curves for amplitude and phase over frequency. Graphs can be displayed for the open and
closed control loops, as well as for the link.
Distinction is made between three set types:
• Record sets represent real recorded values
• Filter sets represent the characteristic curve of a filter
• Result sets represent the combination of two sets in order, for example, to get an idea of how a filter

affects a frequency response.
Among other things, the appearance, e.g. color and line width, can be adjusted in the Properties window.

See also: Set properties [} 27]

Window

The interfaces for the control of the Bode Plot are divided into several individual windows (Tool windows)
and their position and size are freely configurable.
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Overview of the individual windows:

Solution
Explorer

Display of the project structure within a solution.

Error list List of errors, warnings and messages. Each scope project lists the generated messages
independently here. The messages for the respectively selected Scope can be deleted via
the context menu item "Clear Error List".

Properties The settings of the respective element that is marked in the Solution Explorer can be
modified here.

Bode Plot editor Representation of the individual plots of a Bode project. The plots can be displayed next to
each other or in overlapping tabs within the project window, exactly like all other windows.

Configuration

The options for creating or editing a Bode configuration are explained below. The way in which the properties
of the respective elements can be changed is described in the description of the associated window.

Creation of a Measurement project

File → New → Project → TwinCAT Measurement → Selection of the desired template.
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List of the available templates:

Measurement Bode project Appends a Measurement project containing a Bode
project with a plot.

Empty Measurement project Empty Measurement project. Scope configurations
(.sv2 | .tcscope) or scope data (.svd) can
subsequently be inserted here.

Measurement Scope project Contains a Scope instance as well as a pre-
configured chart and an axis.

Measurement Scope project with reporting See "Measurement Scope project" + a ready-made
printing template for printing charts.

Measurement Scope NC project Contains a Scope instance that has been specially
pre-configured for working with axes.

Addition of a Bode project to a Measurement project

Context menu of the Measurement project → Add → New Item… → selection of the desired template.
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List of the available templates:

Bode project Standard Bode project with a Bode Plot

Context menu of the Measurement project → Add → Existing Item... → Selection of the desired file
(.bodeproj)

Drag and drop the desired file (.bodeproj) onto the Measurement project in the Solution Explorer.

Addition of individual elements:

New Plot Context menu of the Bode project instance → New Plot
New Filter Set Context menu of the plot instance → New Filter Set
New Result Set Context menu of the plot instance → New Result Set

Deletion of elements
• Selection of the element in the Solution Explorer → [Del] key.
• Context menu of the element → Delete

Saving a Bode configuration

File → Save (shortcut assigned by default: [Ctrl] + [S])
A file (.bodeproj) is saved in the project directory.

5.1.2 Bode Plot - Scope menu
The Scope functions are accessible via the menu. The corresponding key assignments can also be viewed
here.
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Clear error list Deletes all entries (Error | Warning | Message) of the
currently active Scope from the error list.

New Filter set Adds a new filter set, taking into consideration the
default settings.

New Result set Adds a new result set, taking into consideration the
default settings.

Delete Deletes the element currently selected in the Solution
Explorer.

Local Scope Server... Opens the configuration interface of the Scope Server.
Options... Opens the Visual Studio Options window and selects the

Scope entry.

5.1.3 Bode Plot - Toolbar
The recording of a Bode Plot is started and stopped with the toolbar. The preset parameters for controlling
the specified drive axis are used to traverse the sought frequency profile.

 WARNING
Risk of injury due to the drive axis starting up automatically
In order to make the Bode Plot recording, the drive axis executes a motion sequence that is dependent
upon the settings. At the start of the Bode Plot recording the drive axis starts up automatically in accor-
dance with the set motion profile and can endanger people and material. During the Bode recording the
drive axis remains integrated in the application context (e.g. releases, monitoring, etc.).
• Ensure safety during the Bode Plot recording.

If the toolbar is not visible by default or has been closed, it can be reactivated under View > Toolbars >
TwinCAT Measurement.
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The following elements are available by default in the toolbar:

Start Record: all plots connected to the selected Bode project start recording in parallel. The preset
parameters are used to control the axes.

Stop Record: all plots connected to the selected Bode project abort the recording. The connected
drive axes are reset to the original operation mode.
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5.1.4 Bode Plot - Project properties

Appearance
• View Detail Level: indicates whether the standard view or the extended view for special additional

tasks is to be used in this project. In the default state all properties for the sub-elements (e.g. plots)
necessary to create a Bode plot are visible. The extended mode makes additional properties visible
that could be necessary in order, for example, to create a Scope View from the process data of the
drive in parallel.

Common
• File Name: File name of the current Scope instance.
• File Path: Directory in which the Scope instance was saved.
• Version: Indicates the current version of the configuration.

5.1.5 Bode Plot - Plot properties
All settings for a Bode plot can be assigned here. The following description refers to the representation in
categories (switchable in the Properties toolbar).
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Appearance
• Show Legend: Indicates whether the legend should be shown in the footer of the Bode Plot editor.
• Show Titles: Indicates whether the headings of the charts should be shown in the Bode Plot editor.
• Signal Chart Visibility: Indicates whether the chart with setpoint and actual values of the recording

should be shown or hidden. If Auto is set, the chart is only shown during a running recording.

Bode

Under this category all settings are summarized in order to configure a new Bode Plot.

• Frequency Max: Indicates the upper frequency limit of the Bode Plot [in Hz].
• Frequency Min: Indicates the lower frequency limit of the Bode Plot [in Hz].
• Frequency Steps: Number of interpolation points in the Bode Plot.
• Mode: Sets the Bode Plot mode. The following are available

◦ Torque: Executes a Bode Plot for the torque (or current) interface. (AX5000 only)
◦ Velocity (primary feedback): Executes a Bode Plot for the velocity interface. The actual values of

the primary encoder are used for this. (AX5000 only)
◦ Velocity (dp/dt directly from primary feedback): Executes a Bode Plot for the velocity interface.

(AX5000 only)
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◦ Velocity (secondary feedback): Executes a Bode Plot for the velocity interface. The actual
values of the secondary (external) encoder are used for this. (AX5000 only)

◦ Position (NC interface without oversampling): Executes a Bode Plot for the position.
◦ Velocity (NC interface without oversampling): Executes a Bode Plot for the velocity.
◦ Torque (NC interface without oversampling): Executes a Bode Plot for the torque (or current).

The following settings are shown or hidden, depending on the mode.

• Position Monitoring Window [°]: Defines a window that is monitored during the Bode plot. The object
must not leave this window. The unit actually set is read out and the number is interpreted in
accordance with the unit.

• Position Signal Amplitude [°]: The amplitude of the excitation is set here.
• Velocity Amplitude Scaling Mode: Scales the signal amplitude during the recording so as to not have

to make excessively large movements as the frequency increases. The following are available:
◦ Constant: The amplitude corresponds to the parameterized signal amplitude and remains

constant over the entire frequency range.
◦ 1 / X at 1000Hz: Scales the amplitude so that at 1000 Hz it has fallen to 1/X of the start amplitude

at 1 Hz (~1/f). Useful ratios in practice are 1/5, 1/10 and 1/20.
• Torque Amplitude Offset: Specifies an offset for the torque amplitude [in %].
• Torque Amplitude Scaling Mode: Scales the signal amplitude during the recording, depending on the

current frequency. The following are available:
◦ Autoscale: Scales the amplitude so that it is somewhat larger than the noise at a standstill.
◦ Constant: The signal amplitude remains the same over the entire frequency range. The amplitude

100 means 100 % of the maximum current.
• Torque Signal Amplitude: Sets the amplitude of the signal (or measuring) oscillation at 1 Hz (cf.

Torque Amplitude Scaling Mode). The unit of measurement is to be taken from the system settings
(e.g. Drive, NC, etc.) and cannot be specified here.

• Velocity Base Amplitude: Sets the amplitude of the basic oscillation (~1 Hz) for overcoming the static
friction. The unit of measurement is to be taken from the system settings (e.g. Drive, NC, etc.) and
cannot be specified here.

• Velocity Signal Amplitude: Sets the amplitude of the signal (or measuring) oscillation at 1 Hz (cf.
Velocity Amplitude Scaling Mode). The unit of measurement is to be taken from the system settings
(e.g. Drive, NC, etc.) and cannot be specified here.

Scaling
• Gain Max: Indicates the upper magnitude for the value axis in the chart of the amplitude response.
• Gain Min: Indicates the lower magnitude for the value axis in the chart of the amplitude response.
• Phase Max: Indicates the highest scale end in the chart of the phase response.
• Phase Min: Indicates the lowest scale end in the chart of the phase response.

Target

• Axis ID: indicates the ID of the drive axis that is to be used for this Bode Plot. WARNING The
selected axis may not be part of an axis coupling (e.g. master/slave coupling, CNC hard or soft
gantry). Otherwise, starting the recording can lead to damage to man and the machine.

• Target Net ID: indicates the ID of the target system on which the drive axis is located that is to be used
for this Bode Plot.

Extended View

If "View Detail Level" in the Bode project settings is set to Extended, some additional properties are visible.
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Expert
• Base Frequency: Shows the frequency [in Hz] of the basic oscillation for overcoming the static friction

(in the velocity modes only).
• Bode Object Id: If the Bode Plot is to take place via a "Drive Diag TcCom Object" already set up in the

System Manager (e.g. in order to scope additional process data from the drive), this can take place
here via the Object ID.

• Check Drive Limitations: If a check of the drive is to take place, this can be specified here.
• DynContainerId: Sets the ID of the container for dynamic process data. The DynContainer is

appended to the EtherCAT device in the TwinCAT project.
• Measur Sample Count: Indicates the number of setpoint values and actual values from which an

interpolation value of the Bode characteristic curve (a frequency point) is calculated.
• Measure Time: Indicates the length of time [in s] for which the system is excited with one frequency.
• Signal Generator: Indicates the curve type of the signal generator used.
• System Dead Time: The complete dead time can be entered here in seconds.
• Trace Level: Sets the detail level of the messages generated by the “Drive Diag –TcCom Object” and

displayed in the error list. The available options are Always, Error, Verbose and Warning.
• User Dead Time: The dead time in seconds can be specified here.

Target
• Cycle Time: Indicates the last-used cycle time [in ms].
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• Oversampling: Indicates the oversampling factor to be used. If set to "Suggested", the highest useful
factor is automatically selected when starting the recording.

5.1.6 Bode Plot - Set properties
A Bode Plot can contain three different types of sets (characteristic curves). Record sets for displaying the
result of a recording, Filter sets for assessing the characteristic curve of a filter and Result sets for combining
two already existing sets.

Some settings concern all sets, some are specialized.

Appearance

The settings in the Appearance category are available for all sets.

• Line Colors: Indicates the color of the set (characteristic curves and icon in Solution Explorer).
• Line Width: Sets the line width of the set in the Bode Plot Editor.
• Marks: Indicates whether the interpolation points of the characteristic curve should be displayed.
• Visibility: Indicates which variants of the characteristic curves should be displayed. The following

values and their combinations are available:
• Open Loop: Frequency response of the open control loop.
• Closed Loop: Frequency response of the closed control loop.
• Process: Frequency response of the link.

Record Set

In the settings for the record set, you can see the configuration with which the recording took place.
Therefore, the same values exist here that are already described in the plot.
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Bode

Under this category all settings are summarized in order to configure a new Bode Plot.

• Frequency Steps: Number of interpolation points in the Bode Plot.
• Max Frequency [Hz]: Indicates the upper frequency limit of the Bode Plot [in Hz].
• Min Frequency [Hz]: Indicates the lower frequency limit of the Bode Plot [in Hz].
• Mode: Sets the Bode Plot mode. The following are available

◦ Torque: Executes a Bode Plot for the torque (or current) interface. (AX5000 only)
◦ Velocity (primary feedback): Executes a Bode Plot for the velocity interface. The actual values of

the primary encoder are used for this. (AX5000 only)
◦ Velocity (dp/dt directly from primary feedback): Executes a Bode Plot for the velocity interface.

(AX5000 only)
◦ Velocity (secondary feedback): Executes a Bode Plot for the velocity interface. The actual

values of the secondary (external) encoder are used for this. (AX5000 only)
◦ Position (NC interface without oversampling): Executes a Bode Plot for the position.
◦ Velocity (NC interface without oversampling): Executes a Bode Plot for the velocity.
◦ Torque (NC interface without oversampling): Executes a Bode Plot for the torque (or current).
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The following settings are shown or hidden, depending on the mode:

• Position Monitoring Window [°]: Defines a window that is monitored during the Bode plot. The object
must not leave this window. The unit actually set is read out and the number is interpreted in
accordance with the unit.

• Position Signal Amplitude [°]: The amplitude of the excitation is set here.
• Velocity Amplitude Scaling Mode: Scales the signal amplitude during the recording so as not to

require excessively large movements as the frequency increases. The following are available:
◦ Constant: The amplitude corresponds to the parameterized signal amplitude and remains

constant over the entire frequency range.
◦ 1 / X at 1000Hz: Scales the amplitude so that at 1000 Hz it has fallen to 1/X of the start amplitude

at 1 Hz (~1/f). Useful ratios in practice are 1/5, 1/10 and 1/20.
• Torque Amplitude Offset: Specifies an offset for the torque amplitude [in %].
• Torque Amplitude Scaling Mode: Scales the signal amplitude during the recording, depending on the

current frequency. The following are available:
◦ Autoscale: Scales the amplitude so that it is somewhat higher than the noise at a standstill.
◦ Constant: The signal amplitude remains the same over the entire frequency range. The amplitude

100 means 100 % of the maximum current.
• Torque Signal Amplitude: Sets the amplitude of the signal (or measuring) oscillation at 1 Hz (cf.

Torque Amplitude Scaling Mode). The unit of measurement is to be taken from the system settings
(e.g. Drive, NC, etc.) and cannot be specified here.

• Velocity Base Amplitude: Sets the amplitude of the basic oscillation (~1 Hz) for overcoming the static
friction. The unit of measurement is to be taken from the system settings (e.g. Drive, NC, etc.) and
cannot be specified here.

• Velocity Signal Amplitude: Sets the amplitude of the signal (or measuring) oscillation at 1 Hz (cf.
Velocity Amplitude Scaling Mode). The unit of measurement is to be taken from the system settings
(e.g. Drive, NC, etc.) and cannot be specified here.

Calculation
• Integral Time [s]: This is read during the plot. It is the integral time of the controller that is set on the

drive.
• Proportional Gain: A desired performance can be achieved with the proportional gain.

Expert
• Base Frequency: Shows the frequency [in Hz] of the basic oscillation for overcoming the static friction

(in the velocity modes only).
• Check Drive Limitations: If a check of the drive is to take place, this can be specified here.
• Dead Time [s]: Indicates the complete dead time in seconds.
• Measur Sample Count: Indicates the number of setpoint values and actual values from which an

interpolation value of the Bode characteristic curve (a frequency point) is calculated.
• Measure Time: Indicates the length of time [in s] for which the system is excited with one frequency.
• Signal Generator: Indicates the curve type of the signal generator used.

Target
• Cycle Time: Indicates the last-used cycle time [in ms].
• Oversampling: Indicates the oversampling factor to be used. If set to Suggested, the highest useful

factor is automatically selected when starting the recording.

Filter Set

The special settings for filter sets are represented as follows:
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• Filter Type: The type of filter can be set here. The other properties can be edited, depending on the
selection. The following are available:

• Lowpass 1st Order: First order low-pass.
• Lowpass 2nd Order: Second order low-pass
• Phase Correction 1st Order: First order phase correction link.
• Phase Correction 2nd Order: Second order phase correction link.
• Notch: Notch filter.
• High Pass Damping: High-pass damping factor.
• High Pass Frequency: High-pass frequency [in Hz].
• Low Pass Damping: Low-pass damping factor.
• Low Pass Frequency: Low-pass frequency [in Hz].

Result Set

In order to obtain the overlapping of two already existing sets, they must be specified in the settings for the
result set.

Upon selecting the field, a list of possible sets is displayed.

The resulting characteristic curve is automatically determined from the two sets if the number and position of
the interpolation points correlate. If one of the two source sets changes, then the result set is also re-
calculated.
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Source
• First SourceSet Name: Name of the first source set.
• Second SourceSet Name: Name of the second source set.

5.1.7 Bode Plot - Options
You can go directly to the TwinCAT measurement options in the Visual Studio Options window via the Scope
menu item "Options...".

The standard or default settings that serve as the template for newly created elements can be made here.
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Bode Default Settings

• Bode project: Basic settings for the project can be made here. To detailed description [} 23].
• Bode Plot: Definition of the standard Bode Plot settings that are used when a new Bode Plot is

appended to a project. To detailed description [} 23].
• Filter Set: Definition of the standard filter set settings that are used when a new filter set is appended

to a plot. To detailed description [} 27].
• Record Set: Definition of the standard record set settings that are used when a new recording is

started. To detailed description [} 27].
• Result Set: Definition of the standard result set settings that are used when a new result set is

appended to a plot. To detailed description [} 27].
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6 Samples

6.1 TwinCAT 3 Bode Plot - first steps
In order to enable you to get up and running quickly and to simplify work with the TwinCAT 3 Bode Plot, the
first steps towards a Bode Plot recording are briefly summarized on this page.

If you wish to make a Bode Plot recording of a TwinCAT CNC axis, note the instructions for configuring
TwinCAT CNC axes [} 40] at the end of the section.

 WARNING
Risk of injury due to the drive axis starting up automatically
In order to make the Bode Plot recording, the drive axis executes a motion sequence that is dependent
upon the settings. At the start of the Bode Plot recording the drive axis starts up automatically in accor-
dance with the set motion profile and can endanger people and material. During the Bode recording the
drive axis remains integrated in the application context (e.g. releases, monitoring, etc.).
• Ensure safety during the Bode Plot recording.

1. Installation

For a basic understanding it is important to know that the TwinCAT 3 Bode Plot is part of the Measurement
installation, which also includes the Scope View and the Scope Server. Some functions are used across
Measurement installations. For example, the toolbar controls both Scope and Bode projects. Since all
measurement projects use the Scope Server for the recording of the data, this is always installed as well.
However, it can also be installed individually on a target device via the component installation.

2. Licensing

For the Bode Plot, the “Base” license is initially activated, irrespective of whether it has been installed via its
own Measurement setup or via the TwinCAT 3 XAE setup.

3. New project

Open a new Visual Studio project in one of the installed versions via the context menu of the TwinCAT tray
icon.

A new Visual Studio window opens. Create a new Measurement project via the TwinCAT 3 start page or via
the File menu.
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A window opens showing the existing Measurement templates. Select the already pre-configured Bode Plot
here.
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A solution with a project tree opens in the Solution Explorer. You can find the Bode Plot at the lowest level.
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In the Properties window, set the "Axis ID" and "Target Net ID" for the drive axis with which the Bode Plot is
to be created.

4. Preparing a TwinCAT project:

Before you can execute the actual Bode Plot, you must adjust the settings of the TwinCAT project once only.
Announce the TcNcObjects Class Factory: the Bode Plot is executed by a TcCom object in the TwinCAT
system. To ensure that this can be generated automatically from the Bode project, you must announce the
Class Factory for TcNcObjects.
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Append dynamic containers to the EtherCAT master: for dynamic communication with the drive, reserve a
memory range once only per EtherCAT device. Confirm the subsequent dialog for querying the container
size with OK.
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5. Making a Bode Plot recording

After having selected the target system and the drive axis, you can parameterize the recording in the Plot
properties. The details for the plot settings can be found in the section "Bode Plot - Plot properties [} 23]".
The Bode Plot is started with the "Start Record" button in the Measurement toolbar. During the recording the
current time signals are displayed below in the plot. You can abort the recording at any time with the Stop
button.
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6. Error

If errors should occur during the recording, they are displayed in the Visual Studio error list. For example, the
Bode Plot signals a missing axis release when trying to start the recording.

However, the error list only displays the errors output by projects that are part of the active solution. 
Example: If a lag error is signaled for the drive axis and the project is not part of the active solution, a general
Bode Plot error is output.
If the project is part of the active solution, then the lag error is also output in the error list.

7. Analysis

Following the recording you can see all the characteristic curves created so far. You can change the display
options in the properties. For example, it may be useful to view the "path" as well as the "open control loop"
and "closed control loop", or to highlight or mask individual characteristic curves. Details for the settings can
be found in the section "Bode Plot - Set properties [} 27]".
Beyond that you can also append filter sets for the simulation of filters or result sets for the determination of
overlapping results.
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Notes on the configuration of TwinCAT CNC axes

If a Bode Plot recording is to be made of a TwinCAT CNC axis, the matching speed standardization f must
be set for this in the axis parameter set.
On the basis of the AX5000's internal speed scaling (1 increment corresponds to a speed of 5.588 x 10-5

rpm), the following equation is used for the calculation:

with

f: scaling factor [µm/min] or [10-3°/min]

d: feed per motor revolution [µm/rev] or [10-3°/rev]

i: gear ratio [-]

The resulting factor must then be entered in the axis parameter set for the respective axis. This is done by
means of the parameters P-AXIS-00205 - P-AXIS-00207.

Example:

Linear axis with 5 mm feed per motor revolution and gear ratio 4.

This results in the following axis parameters:

antr.v_time_base 0 (P-AXIS-00207: time base = 1/min )
antr.v_reso_num 100000 (P-AXIS-00206: standardization factor counter)
antr.v_reso_denom 6985 (P-AXIS-00205: standardization factor denominator)

Further information on the axis parameters can be found in the Beckhoff information system in the
documentation "TwinCAT CNC". (TwinCAT 2 > TwinCAT NC > TwinCAT CNC > TwinCAT CNC axis
parameters)
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7 Appendix

7.1 Return values

7.1.1 ADS Return Codes
Grouping of error codes: 0x000 [} 41]..., 0x500 [} 41]..., 0x700 [} 42]..., 0x1000 [} 44]...

Global error codes

Hex Dec HRESULT Name Description
0x0 0 0x9811 0000 ERR_NOERROR No error.
0x1 1 0x9811 0001 ERR_INTERNAL Internal error.
0x2 2 0x9811 0002 ERR_NORTIME No real-time.
0x3 3 0x9811 0003 ERR_ALLOCLOCKEDMEM Allocation locked – memory error.
0x4 4 0x9811 0004 ERR_INSERTMAILBOX Mailbox full – the ADS message could not be sent.

Reducing the number of ADS messages per cycle
will help.

0x5 5 0x9811 0005 ERR_WRONGRECEIVEHMSG Wrong HMSG.
0x6 6 0x9811 0006 ERR_TARGETPORTNOTFOUND Target port not found – ADS server is not started or

is not reachable.
0x7 7 0x9811 0007 ERR_TARGETMACHINENOTFOUND Target computer not found – AMS route was not

found.
0x8 8 0x9811 0008 ERR_UNKNOWNCMDID Unknown command ID.
0x9 9 0x9811 0009 ERR_BADTASKID Invalid task ID.
0xA 10 0x9811 000A ERR_NOIO No IO.
0xB 11 0x9811 000B ERR_UNKNOWNAMSCMD Unknown AMS command.
0xC 12 0x9811 000C ERR_WIN32ERROR Win32 error.
0xD 13 0x9811 000D ERR_PORTNOTCONNECTED Port not connected.
0xE 14 0x9811 000E ERR_INVALIDAMSLENGTH Invalid AMS length.
0xF 15 0x9811 000F ERR_INVALIDAMSNETID Invalid AMS Net ID.
0x10 16 0x9811 0010 ERR_LOWINSTLEVEL Installation level is too low –TwinCAT 2 license er-

ror.
0x11 17 0x9811 0011 ERR_NODEBUGINTAVAILABLE No debugging available.
0x12 18 0x9811 0012 ERR_PORTDISABLED Port disabled – TwinCAT system service not

started.
0x13 19 0x9811 0013 ERR_PORTALREADYCONNECTED Port already connected.
0x14 20 0x9811 0014 ERR_AMSSYNC_W32ERROR AMS Sync Win32 error.
0x15 21 0x9811 0015 ERR_AMSSYNC_TIMEOUT AMS Sync Timeout.
0x16 22 0x9811 0016 ERR_AMSSYNC_AMSERROR AMS Sync error.
0x17 23 0x9811 0017 ERR_AMSSYNC_NOINDEXINMAP No index map for AMS Sync available.
0x18 24 0x9811 0018 ERR_INVALIDAMSPORT Invalid AMS port.
0x19 25 0x9811 0019 ERR_NOMEMORY No memory.
0x1A 26 0x9811 001A ERR_TCPSEND TCP send error.
0x1B 27 0x9811 001B ERR_HOSTUNREACHABLE Host unreachable.
0x1C 28 0x9811 001C ERR_INVALIDAMSFRAGMENT Invalid AMS fragment.
0x1D 29 0x9811 001D ERR_TLSSEND TLS send error – secure ADS connection failed.
0x1E 30 0x9811 001E ERR_ACCESSDENIED Access denied – secure ADS access denied.

Router error codes
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Hex Dec HRESULT Name Description
0x500 1280 0x9811 0500 ROUTERERR_NOLOCKEDMEMORY Locked memory cannot be allocated.

0x501 1281 0x9811 0501 ROUTERERR_RESIZEMEMORY The router memory size could not be changed.

0x502 1282 0x9811 0502 ROUTERERR_MAILBOXFULL The mailbox has reached the maximum number of
possible messages.

0x503 1283 0x9811 0503 ROUTERERR_DEBUGBOXFULL The Debug mailbox has reached the maximum
number of possible messages.

0x504 1284 0x9811 0504 ROUTERERR_UNKNOWNPORTTYPE The port type is unknown.
0x505 1285 0x9811 0505 ROUTERERR_NOTINITIALIZED The router is not initialized.
0x506 1286 0x9811 0506 ROUTERERR_PORTALREADYINUSE The port number is already assigned.
0x507 1287 0x9811 0507 ROUTERERR_NOTREGISTERED The port is not registered.
0x508 1288 0x9811 0508 ROUTERERR_NOMOREQUEUES The maximum number of ports has been reached.
0x509 1289 0x9811 0509 ROUTERERR_INVALIDPORT The port is invalid.
0x50A 1290 0x9811 050A ROUTERERR_NOTACTIVATED The router is not active.
0x50B 1291 0x9811 050B ROUTERERR_FRAGMENTBOXFULL The mailbox has reached the maximum number for

fragmented messages.
0x50C 1292 0x9811 050C ROUTERERR_FRAGMENTTIMEOUT A fragment timeout has occurred.
0x50D 1293 0x9811 050D ROUTERERR_TOBEREMOVED The port is removed.

General ADS error codes
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Hex Dec HRESULT Name Description
0x700 1792 0x9811 0700 ADSERR_DEVICE_ERROR General device error.
0x701 1793 0x9811 0701 ADSERR_DEVICE_SRVNOTSUPP Service is not supported by the server.
0x702 1794 0x9811 0702 ADSERR_DEVICE_INVALIDGRP Invalid index group.
0x703 1795 0x9811 0703 ADSERR_DEVICE_INVALIDOFFSET Invalid index offset.
0x704 1796 0x9811 0704 ADSERR_DEVICE_INVALIDACCESS Reading or writing not permitted.
0x705 1797 0x9811 0705 ADSERR_DEVICE_INVALIDSIZE Parameter size not correct.
0x706 1798 0x9811 0706 ADSERR_DEVICE_INVALIDDATA Invalid data values.
0x707 1799 0x9811 0707 ADSERR_DEVICE_NOTREADY Device is not ready to operate.
0x708 1800 0x9811 0708 ADSERR_DEVICE_BUSY Device is busy.
0x709 1801 0x9811 0709 ADSERR_DEVICE_INVALIDCONTEXT Invalid operating system context. This can result

from use of ADS function blocks in different tasks. It
may be possible to resolve this through Multi-task
data access synchronization in the PLC.

0x70A 1802 0x9811 070A ADSERR_DEVICE_NOMEMORY Insufficient memory.
0x70B 1803 0x9811 070B ADSERR_DEVICE_INVALIDPARM Invalid parameter values.
0x70C 1804 0x9811 070C ADSERR_DEVICE_NOTFOUND Not found (files, ...).
0x70D 1805 0x9811 070D ADSERR_DEVICE_SYNTAX Syntax error in file or command.
0x70E 1806 0x9811 070E ADSERR_DEVICE_INCOMPATIBLE Objects do not match.
0x70F 1807 0x9811 070F ADSERR_DEVICE_EXISTS Object already exists.
0x710 1808 0x9811 0710 ADSERR_DEVICE_SYMBOLNOTFOUND Symbol not found.
0x711 1809 0x9811 0711 ADSERR_DEVICE_SYMBOLVERSIONIN-

VALID
Invalid symbol version. This can occur due to an on-
line change. Create a new handle.

0x712 1810 0x9811 0712 ADSERR_DEVICE_INVALIDSTATE Device (server) is in invalid state.
0x713 1811 0x9811 0713 ADSERR_DEVICE_TRANSMODENOTSUPP AdsTransMode not supported.
0x714 1812 0x9811 0714 ADSERR_DEVICE_NOTIFYHNDINVALID Notification handle is invalid.
0x715 1813 0x9811 0715 ADSERR_DEVICE_CLIENTUNKNOWN Notification client not registered.
0x716 1814 0x9811 0716 ADSERR_DEVICE_NOMOREHDLS No further handle available.
0x717 1815 0x9811 0717 ADSERR_DEVICE_INVALIDWATCHSIZE Notification size too large.
0x718 1816 0x9811 0718 ADSERR_DEVICE_NOTINIT Device not initialized.
0x719 1817 0x9811 0719 ADSERR_DEVICE_TIMEOUT Device has a timeout.
0x71A 1818 0x9811 071A ADSERR_DEVICE_NOINTERFACE Interface query failed.
0x71B 1819 0x9811 071B ADSERR_DEVICE_INVALIDINTERFACE Wrong interface requested.
0x71C 1820 0x9811 071C ADSERR_DEVICE_INVALIDCLSID Class ID is invalid.
0x71D 1821 0x9811 071D ADSERR_DEVICE_INVALIDOBJID Object ID is invalid.
0x71E 1822 0x9811 071E ADSERR_DEVICE_PENDING Request pending.
0x71F 1823 0x9811 071F ADSERR_DEVICE_ABORTED Request is aborted.
0x720 1824 0x9811 0720 ADSERR_DEVICE_WARNING Signal warning.
0x721 1825 0x9811 0721 ADSERR_DEVICE_INVALIDARRAYIDX Invalid array index.
0x722 1826 0x9811 0722 ADSERR_DEVICE_SYMBOLNOTACTIVE Symbol not active.
0x723 1827 0x9811 0723 ADSERR_DEVICE_ACCESSDENIED Access denied.
0x724 1828 0x9811 0724 ADSERR_DEVICE_LICENSENOTFOUND Missing license.
0x725 1829 0x9811 0725 ADSERR_DEVICE_LICENSEEXPIRED License expired.
0x726 1830 0x9811 0726 ADSERR_DEVICE_LICENSEEXCEEDED License exceeded.
0x727 1831 0x9811 0727 ADSERR_DEVICE_LICENSEINVALID Invalid license.
0x728 1832 0x9811 0728 ADSERR_DEVICE_LICENSESYSTEMID License problem: System ID is invalid.
0x729 1833 0x9811 0729 ADSERR_DEVICE_LICENSENOTIMELIMIT License not limited in time.
0x72A 1834 0x9811 072A ADSERR_DEVICE_LICENSEFUTUREISSUE License problem: Time in the future.
0x72B 1835 0x9811 072B ADSERR_DEVICE_LICENSETIMETOLONG License period too long.
0x72C 1836 0x9811 072C ADSERR_DEVICE_EXCEPTION Exception at system startup.
0x72D 1837 0x9811 072D ADSERR_DEVICE_LICENSEDUPLICATED License file read twice.
0x72E 1838 0x9811 072E ADSERR_DEVICE_SIGNATUREINVALID Invalid signature.
0x72F 1839 0x9811 072F ADSERR_DEVICE_CERTIFICATEINVALID Invalid certificate.
0x730 1840 0x9811 0730 ADSERR_DEVICE_LICENSEOEMNOT-

FOUND
Public key not known from OEM.

0x731 1841 0x9811 0731 ADSERR_DEVICE_LICENSERESTRICTED License not valid for this system ID.
0x732 1842 0x9811 0732 ADSERR_DEVICE_LICENSEDEMODENIED Demo license prohibited.
0x733 1843 0x9811 0733 ADSERR_DEVICE_INVALIDFNCID Invalid function ID.
0x734 1844 0x9811 0734 ADSERR_DEVICE_OUTOFRANGE Outside the valid range.
0x735 1845 0x9811 0735 ADSERR_DEVICE_INVALIDALIGNMENT Invalid alignment.
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Hex Dec HRESULT Name Description
0x736 1846 0x9811 0736 ADSERR_DEVICE_LICENSEPLATFORM Invalid platform level.
0x737 1847 0x9811 0737 ADSERR_DEVICE_FORWARD_PL Context – forward to passive level.
0x738 1848 0x9811 0738 ADSERR_DEVICE_FORWARD_DL Context – forward to dispatch level.
0x739 1849 0x9811 0739 ADSERR_DEVICE_FORWARD_RT Context – forward to real-time.
0x740 1856 0x9811 0740 ADSERR_CLIENT_ERROR Client error.
0x741 1857 0x9811 0741 ADSERR_CLIENT_INVALIDPARM Service contains an invalid parameter.
0x742 1858 0x9811 0742 ADSERR_CLIENT_LISTEMPTY Polling list is empty.
0x743 1859 0x9811 0743 ADSERR_CLIENT_VARUSED Var connection already in use.
0x744 1860 0x9811 0744 ADSERR_CLIENT_DUPLINVOKEID The called ID is already in use.
0x745 1861 0x9811 0745 ADSERR_CLIENT_SYNCTIMEOUT Timeout has occurred – the remote terminal is not

responding in the specified ADS timeout. The route
setting of the remote terminal may be configured in-
correctly.

0x746 1862 0x9811 0746 ADSERR_CLIENT_W32ERROR Error in Win32 subsystem.
0x747 1863 0x9811 0747 ADSERR_CLIENT_TIMEOUTINVALID Invalid client timeout value.
0x748 1864 0x9811 0748 ADSERR_CLIENT_PORTNOTOPEN Port not open.
0x749 1865 0x9811 0749 ADSERR_CLIENT_NOAMSADDR No AMS address.
0x750 1872 0x9811 0750 ADSERR_CLIENT_SYNCINTERNAL Internal error in Ads sync.
0x751 1873 0x9811 0751 ADSERR_CLIENT_ADDHASH Hash table overflow.
0x752 1874 0x9811 0752 ADSERR_CLIENT_REMOVEHASH Key not found in the table.
0x753 1875 0x9811 0753 ADSERR_CLIENT_NOMORESYM No symbols in the cache.
0x754 1876 0x9811 0754 ADSERR_CLIENT_SYNCRESINVALID Invalid response received.
0x755 1877 0x9811 0755 ADSERR_CLIENT_SYNCPORTLOCKED Sync Port is locked.

RTime error codes

Hex Dec HRESULT Name Description
0x1000 4096 0x9811 1000 RTERR_INTERNAL Internal error in the real-time system.
0x1001 4097 0x9811 1001 RTERR_BADTIMERPERIODS Timer value is not valid.
0x1002 4098 0x9811 1002 RTERR_INVALIDTASKPTR Task pointer has the invalid value 0 (zero).
0x1003 4099 0x9811 1003 RTERR_INVALIDSTACKPTR Stack pointer has the invalid value 0 (zero).
0x1004 4100 0x9811 1004 RTERR_PRIOEXISTS The request task priority is already assigned.
0x1005 4101 0x9811 1005 RTERR_NOMORETCB No free TCB (Task Control Block) available. The

maximum number of TCBs is 64.
0x1006 4102 0x9811 1006 RTERR_NOMORESEMAS No free semaphores available. The maximum num-

ber of semaphores is 64.
0x1007 4103 0x9811 1007 RTERR_NOMOREQUEUES No free space available in the queue. The maximum

number of positions in the queue is 64.

0x100D 4109 0x9811 100D RTERR_EXTIRQALREADYDEF An external synchronization interrupt is already ap-
plied.

0x100E 4110 0x9811 100E RTERR_EXTIRQNOTDEF No external sync interrupt applied.
0x100F 4111 0x9811 100F RTERR_EXTIRQINSTALLFAILED Application of the external synchronization interrupt

has failed.
0x1010 4112 0x9811 1010 RTERR_IRQLNOTLESSOREQUAL Call of a service function in the wrong context
0x1017 4119 0x9811 1017 RTERR_VMXNOTSUPPORTED Intel VT-x extension is not supported.
0x1018 4120 0x9811 1018 RTERR_VMXDISABLED Intel VT-x extension is not enabled in the BIOS.
0x1019 4121 0x9811 1019 RTERR_VMXCONTROLSMISSING Missing function in Intel VT-x extension.
0x101A 4122 0x9811 101A RTERR_VMXENABLEFAILS Activation of Intel VT-x fails.

TCP Winsock error codes

Hex Dec Name Description
0x274C 10060 WSAETIMEDOUT A connection timeout has occurred - error while establishing the connection, because

the remote terminal did not respond properly after a certain period of time, or the es-
tablished connection could not be maintained because the connected host did not re-
spond.

0x274D 10061 WSAECONNREFUSED Connection refused - no connection could be established because the target computer
has explicitly rejected it. This error usually results from an attempt to connect to a ser-
vice that is inactive on the external host, that is, a service for which no server applica-
tion is running.

0x2751 10065 WSAEHOSTUNREACH No route to host - a socket operation referred to an unavailable host.
More Winsock error codes: Win32 error codes
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7.1.2 Bode Return Codes
The following bode plot specific error codes are used in the bode plot server:
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Code (Hex) Code (Dec) Symbol Description
0x8100 33024 INTERNAL Internal error
0x8101 33025 NOTINITIALIZED Not initialized (e.g. no nc axis)
0x8102 33026 INVALIDPARAM Invalid parameter
0x8103 33027 INVALIDOFFSET Invalid index offset
0x8104 33028 INVALIDSIZE Invalid parameter size
0x8105 33029 INVALIDSTARTPARAM Invalid start parameter (set point generator)
0x8106 33030 NOTSUPPORTED Not supported
0x8107 33031 AXISNOTENABLED Nc axis not enabled
0x8108 33032 AXISINERRORSTATE Nc axis in error state
0x8109 33033 DRIVEINERRORSTATE IO drive in error state
0x810A 33034 AXISANDDRIVEINERROR-

STATE
Nc axis AND IO drive in error state

0x810B 33035 INVALIDDRIVEOPMODE Invalid drive operation mode active or
requested 
(no bode plot mode)

0x810C 33036 INVALIDCONTEXT Invalid context for this command (mandatory
task or windows context needed)

0x810D 33037 NOAXISINTERFACE Missing TCom axis interface (axis null
pointer).
There is no connection to the NC axis.
Either no axis (or axis ID) has been
parameterized, or the parameterized axis
does not exist.

0x810E 33038 INPUTCYCLECOUNTER Invalid input cycle counter from IO drive
(e.g. frozen).
The cyclic drive data are backed up by an
‘InputCycleCounter’ during the bode plot
recording. This allows firstly the detection of
an unexpected communication loss (keyword:
LifeCounter) and secondly a check for
temporal data consistency to be performed.
Sample 1: This error can occur if the cycle
time of the calling task is larger than the
assumed drive cycle time (in this case,
however, the error occurs right at the start of
the recording).
Sample 2: This error can occur if the calling
task has real-time errors (e.g. the "Exceed
Counter" of the task increments or the task
has a lower priority, as is often the case, for
example, with the PLC). In this case the error
can also occur at any time during the
recording.
Sample 3: This error can occur more
frequently if the real-time load on the
computer is quite high (>50 %).
Note: Refer also to the corresponding
AX5000 drive error code F440.
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Code (Hex) Code (Dec) Symbol Description
0x810F 33039 POSITIONMONITORING

(=> NC Runtime Error)
Position monitoring: Axis position is
outside of the maximum allowed moving
range.
The axis has left the parameterized position
range window, whereupon the recording was
aborted and the NC axis was placed in the
error state 0x810F (with standard NC error
handling).
The position range window acts symmetrically
around the initial position of the axis (see also
parameter description Position Monitoring
Window).
Typical error message in the logger:
"BodePlot: 'Position Monitoring' error 0x%x
because the actual position %f is above the
maximum limit %f of the allowed position
range (StartPos=%f, Window=%f)"

0x8110 33040 DRIVELIMITATIONDETECTED Driver limitations detected (current or
velocity limitations) which causes a
nonlinear behavior and invalid results of
the bode plot.
A bode plot recording requires an
approximately linear transmission link. If the
speed or current is limited in the drive unit,
however, this non-linear behavior is detected
and the bode plot recording is aborted.
Reasons for these limitations can be:
choosing too large an amplitude for the
position, speed or torque interface, or an
unsuitable choice of amplitude scaling mode
(see also parameter description Amplitude
Scaling Mode, Base Amplitude, Signal
Amplitude).
Typical error message in the logger:
"BodePlot: Sequence aborted with error 0x%x
because the current limit of the drive has
been exceeded (%d times) which causes a
nonlinear behavior and invalid results of the
bode plot"

0x8111 33041 LIFECOUNTERMONITORING
(=> NC Runtime Error)

Life counter monitoring (heartbeat): Lost
of communication to GUI detected after
watchdog timeout is elapsed.
The graphical user interface from which the
bode plot recording was started is no longer
communicating with the bode plot driver in the
expected rhythm (keyword: ‘Life Counter’).
Therefore the recording is terminated
immediately and the NC axes are placed in
the error state 0x8111 (with standard NC
error handling). Possible reasons for this can
be an operating interface crash or a major
malfunction of the Windows context.
Typical error message in the logger:
"BodePlot: Sequence aborted with GUI Life
Counter error 0x%x because the WatchDog
timeout of %f s elapsed ('%s')"
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Code (Hex) Code (Dec) Symbol Description
0x8112 33042 NCERR_BODEPLOT_WCSTA

TE
WC state error (IO data working counter)
IO working counter error (WC state), for
example due to real-time errors, EtherCAT
CRC errors or telegram failures, EtherCAT
device not communicating (OP state), etc.

0x8113-
0x811F

33043-
33055

RESERVED Reserved area

7.2 FAQ - frequently asked questions and answers
Frequently asked questions are answered in this section in order to make it easier for you to work with
TwinCAT 3 Bode Plot.
If you have any further questions, please contact our support (-157) and ask to speak to a drive expert.

1. Can a machine get into a critical situation due to the Bode function? [} 48]
2. The Bode recording is started and nothing happens. What could be the cause? [} 48]
3. Can the Bode function be executed in U/F mode with an asynchronous motor? [} 48]
4. Can the Bode function be started with vertical axes? [} 48]
5. How does the Bode function behave on axes with play? [} 48]
6. Can the Bode function be used with "non-Beckhoff motors"? [} 48]
7. How many measuring points should be selected for a meaningful representation? [} 49]
8. Which measuring ranges are useful? [} 49]
9. Does the NC cycle time have an effect on the Bode representation? [} 49]

10. What system requirements must my PC fulfill? [} 49]
11. Are open source software components used in TwinCAT Measurement products? [} 49]

Can a machine get into a critical situation due to the Bode function?

Yes, undesired movements may occur due to the occurrence of a mechanical resonance. A functioning
emergency stop circuit is therefore essential.

The Bode recording is started and nothing happens. What could be the cause?

Possible causes could be:

• The axis is not released.
• There is a drive error. (This can be read in the TC_Drive_Manager).
• Safety has canceled the release.
• Lag error monitoring is active.

Can the Bode function be executed in U/F mode with an asynchronous motor?

No, the Bode function is possible only in controlled mode with feedback.

Can the Bode function be started with vertical axes?

Yes, but only in the "Velocity" mode. Note that "drifting " of the axis can occur here. If the axis is equipped
with pneumatic assistance, this damping also affects the measurement result.

How does the Bode function behave on axes with play?

The mass may be metrologically decoupled. It is particularly important here to adapt the fundamental
oscillation and measuring amplitude.

Can the Bode function be used with "non-Beckhoff motors"?

Yes, there is no manufacturer limitation.
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How many measuring points should be selected for a meaningful representation?

10 to 20 per decade and of course more if necessary.

Which measuring ranges are useful?

5 - 500 Hz in Velocity mode, 50 - 3000 Hz in Current mode.

Does the NC cycle time have an effect on the Bode representation?

The measured values are transmitted in so-called dynamic containers. Furthermore, the oversampling
method ensures precise reproduction of the measured values. The NC cycle time should be around </=
2 ms.

What system requirements must my PC fulfill?

At least TC3.1X4016.x XAE and the system requirements associated with it.

Are open source software components used in TwinCAT Measurement products?

Yes, various open source components are used. 
Please see the information on the page Third-party components [} 51].

7.3 Support and Service
Beckhoff and their partners around the world offer comprehensive support and service, making available fast
and competent assistance with all questions related to Beckhoff products and system solutions.

Beckhoff's branch offices and representatives

Please contact your Beckhoff branch office or representative for local support and service on Beckhoff
products!

The addresses of Beckhoff's branch offices and representatives round the world can be found on her internet
pages: https://www.beckhoff.com

You will also find further documentation for Beckhoff components there.

Beckhoff Support

Support offers you comprehensive technical assistance, helping you not only with the application of
individual Beckhoff products, but also with other, wide-ranging services:

• support
• design, programming and commissioning of complex automation systems
• and extensive training program for Beckhoff system components

Hotline: +49 5246 963 157
Fax: +49 5246 963 9157
e-mail: support@beckhoff.com

Beckhoff Service

The Beckhoff Service Center supports you in all matters of after-sales service:

• on-site service
• repair service
• spare parts service
• hotline service

https://www.beckhoff.com/support
https://www.beckhoff.com
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Hotline: +49 5246 963 460
Fax: +49 5246 963 479
e-mail: service@beckhoff.com

Beckhoff Headquarters

Beckhoff Automation GmbH & Co. KG

Huelshorstweg 20
33415 Verl
Germany

Phone: +49 5246 963 0
Fax: +49 5246 963 198
e-mail: info@beckhoff.com
web: https://www.beckhoff.com

https://www.beckhoff.com
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7.4 Third-party components
This software contains third-party components.
Please refer to the license file provided in the following folder for further information:
…\TwinCAT\Functions\TwinCAT Measurement\Legal
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Glossary
Bode Diagramm/Plot

Displays two functional graphs, one of which
shows the amplitude gain and the other the
phase shift.

Filter Set
Displays the characteristic curve of a filter in
the TwinCAT Bode Plot project.

Record Set
Displays the result of a real measurement in
the TwinCAT Bode Plot project in Visual Stu-
dio.

Result Set
Displays the combined result of two already ex-
isting sets.





Beckhoff Automation GmbH & Co. KG
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33415 Verl
Germany
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More Information: 
www.beckhoff.de/te1320
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